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Arduino

Arduino

myDAQ dobrze sprawdza się do akwizycji danych, jednak możliwości
generowania sygnałów są ograniczone np. brak wyjścia PWM.
Gdy potrzebujemy generować sygnały i obsługiwać pojedyncze
sensory lepiej sprawdzi się mikrokontroler np. arduino.
Aby skorzystać z arduino pod LabVIEW należy zainstalować jedną z
dwóch dostępnych bibliotek LIFA lub LINX (wykorzystywaną na
laboratoriach z PPPW) korzystając VI Packages Manager.
Więcej na temat Arduino (ale z wykorzystaniem C++) na
przedmiocie: Podstawy Systemów Wbudowanych.
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Arduino

Biblioteka LINX

Biblioteka LINX może być użyta do komunikacji z Arduino, Raspberry
Pi, myRIO oraz chipKIT.
Biblioteka ta została stworzona przez LabVIEW MakerHub,
organizację wspierającą środowisko makers przy użyciu LabVIEW.
Więcej na stronie: https://www.labviewmakerhub.com/.
Biblioteka LINX zawiera podstawowe funkcji takie jak:

Open Serial - funkcja, która rozpoczyna połączenie z urządzeniem na
wybranym porcie szeregowym.
Close - funkcja, która kończy połączenie z danym urządzeniem.

oraz funkcje zgrupowane w katalogach:
Peripherals → Analog - do obsługi wejść analogowych.
Peripherals → Digital - do obsługi wejść/wyjść cyfrowych.
Peripherals → PWM - do obsługi wyjść generujących sygnał PWM.
Peripherals → I2C - do obsługi magistrali I2C.
Peripherals → SPI - do obsługi magistrali SPI.
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Arduino

Aby wgrać firmware do Arduino należy po uruchomieniu LabVIEW
wybrać: Tools → MakerHub → LINX → LINX firmware
Wizard... a następnie wybrać odpowiedni typ płytki Arduino oraz
port szeregowy.
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Arduino

Przykład 1
Biblioteka LINX umożliwia odczytywanie i wysyłanie sygnałów
cyfrowych.
Pierwszy przykładowy program ma na celu zapalenie/zgaszenie diody
LED.
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Arduino

Przykład 2

Program ma na celu zapalenie diody LED po wykryciu ruchu przez
czujnik PIR.
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Arduino

Przykład 3

Program odczytuje napięcie zwracane przez czujnik temperatury
LM35. Napięcie te jest proporcjonalne do temperatury.
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Arduino

Przykład 4
Biblioteka LINX umożliwia również generowanie sygnałów PWM za pomocą
funkcji PWM Set Duty Cycle.
Funkcja ta przyjmuje na wejście numer pinu, na którym ma wygenerować
sygnał PWM oraz wypełnienie (wartość numeryczna z zakresu 0-1 przy
czym 1 oznacza 100%).

Więcej przykładów w książce: ”LabVIEW and Open Source Solutions”
Dariusz Tefelski, Angelika Tefelska.
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Zaawansowane operacje na plikach

Zaawansowane operacje na plikach
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Zaawansowane operacje na plikach Tworzenie plików i folderów

Metody tworzenia ścieżek do plików i folderów

Poprzez wpisanie na ”sztywno” ścieżki:
Metoda użyteczna przy tworzeniu prototypów.
Nie zalecana do aplikacji.

File Dialog (wyskakuje gdy ścieżka do funkcji zapisu danych nie jest
podana):

Umożliwia użytkownikowi wybór ścieżki do pliku lub katalogu.
Poprzez utworzenie zależnej ścieżki korzystając ze stałych w
LabVIEW:

Tworzenie wzorców nazw plików i rozszerzeń np. test 001.txt,
test 002.txt itd.
Logiczne grupowanie plików w katalogach.
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Zaawansowane operacje na plikach Tworzenie plików i folderów

Tworzenie zależnej ścieżki

Tworzenie zależnych ścieżek i folderów umożliwia ominięcie problemu
z różnymi ścieżkami dla różnych kont użytkowników pod różnymi
systemami operacyjnymi.
Przydatne funkcje:

Application Directory VI - zwraca lokalizację projektu.
Get System Directory VI - zwraca ścieżkę do katalogu głównego.
Build Path - tworzy ścieżkę.
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Zaawansowane operacje na plikach Tworzenie plików i folderów

Tworzenie folderu

Funkcja umożliwiająca utworzenie folderu to Create Folder.
Dobrą praktyką jest sprawdzenie czy dany folder już istnieje. W
przeciwnym wypadku możemy uzyskać błąd przy próbie nadpisania
istniejącego folderu.
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Zaawansowane operacje na plikach Tworzenie plików i folderów

Dynamiczne tworzenie ścieżek i nazw plików
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Zaawansowane operacje na plikach Tworzenie plików i folderów
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Zaawansowane operacje na plikach Praca z wieloma kolumnami danych

Zapis wielu kolumn danych

Przed zapisem danych do plików ważne jest obrócenie tablicy z
danymi. W przeciwnym razie kolejne elementy kolumny nie będą
zapisane pionowo lecz poziomo.
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Zaawansowane operacje na plikach Praca z wieloma kolumnami danych

Odczyt wielu kolumn danych
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Zaawansowane operacje na plikach Pliki Binarne

Zapis danych do pliku binarnego
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Zaawansowane operacje na plikach Pliki Binarne

Odczyt danych z pliku binarnego
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Podsumowanie

Czas na podsumowanie tej części wykładu!
Zamiast tekstu, seria pytań!
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Podsumowanie

Podsumowanie
Który z rodzajów zapisu danych wygeneruje plik o najmniejszym
rozmiarze?
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Obsługa błędów

Obsługa błędów
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Obsługa błędów

Obsługa błędów

Błędy i ostrzeżenia są przekazywane w formie klastra, który składa się
z trzech elementów:

status - wartość logiczna, która przyjmuje wartość TRUE w przypadku
błędu. Ostrzeżenia mają status FALSE.
code - 32-bit signed integer.
source - string, opis pomagający zidentyfikować źródło błędu.

Ostrzeżenia posiadają status=FALSE oraz code 6=0.
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Obsługa błędów

Jak używać klastra błędów?

Korzystanie z klastra błędów jest istotnym elementem profesjonalnych
aplikacji.
Przekazuj klaster błędów pomiędzy funkcjami, które posiadają
terminale error in/error out.
Pomiędzy kolejnymi iteracjami pętli for/while przekazuj klaster
błędów korzystając z rejestru przesuwnego.
Łącz klastry błędów za pomocą funkcji Merge Errors, co umożliwi
obsługę wszystkich powstałych błędów.
Jeśli dany fragment kodu może nie działać poprawnie gdy użytkownik
wprowadzi nieprawidłowe dane, stwórz samemu błąd i przekaż do
klastra błędów odpowiednią informacje.
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Obsługa błędów

Jak używać klastra błędów?

Korzystaj z funkcji umożliwiających wyświetlenie okienka z
informacjami o błędzie.
Takie narzędzia są szczególnie istotne gdy aplikacja będzie
udostępniana innym jako plik wykonywalny (exe). Przy odtwarzaniu
pliku wynikowego użytkownik nie ma dostępu do listy błędów (Error
List).
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Obsługa błędów

General Error Handler
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Obsługa błędów

Dialog box

Gotowe funkcje do wyświetlania
błędów są niezwykle przydatne.
Jednak często chcielibyśmy
przechwycić błąd i zapytać
użytkownika co zrobić dalej:
powtórzyć daną operacje czy
może zamknąć program. Do
tego przydają się dialog box.

Angelika Tefelska PPPW 2022/2023 29 / 83



Obsługa błędów

One button dialog
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Obsługa błędów

Two button dialog
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Obsługa błędów

Dodawanie własnego błędu do klastra

Dodawanie własnych kodów błędów jest korzystne gdyż jako twórcy
oprogramowania możemy przewidzieć więcej sytuacji powodujących
nieprawidłowe działanie programu i im przeciwdziałać.
LabVIEW zapewnia nam kilka zakresów wartości kodów, które
możemy wykorzystać:

(-8999;-8000)
(5000, 9999)
(500 000, 599 999)

Pozostałe wartości kodów są zarezerwowane przez inne funkcje.
Dokładna dokumentacja kodów błędów jest dostępna na stronie
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Obsługa błędów

Dodawanie własnego błędu do klastra
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Obsługa błędów

Dodawanie własnego błędu do klastra - przykład
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Obsługa błędów

Dodawanie własnego błędu do klastra - przykład

Angelika Tefelska PPPW 2022/2023 39 / 83



Udoskonalanie istniejącego kodu
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Udoskonalanie istniejącego kodu

Refaktoryzacja

Refaktoryzacja - to proces przeprojektowywania aplikacji aby stała się
bardziej czytelna i łatwiejsza w rozbudowie w przyszłości.
Kiedy zabrać się za refaktoryzacje?

Wtedy gdy dodanie nowej funkcjonalności zabiera zbyt dużo czasu i
wymaga znaczących zmian w istniejącym kodzie.
Kiedy aplikacja nie spełnia Twoich wymagań w satysfakcjonujący
sposób.
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Udoskonalanie istniejącego kodu

Schemat refaktoryzacji

Problemy do rozwiązania:
Brak organizacji
Zbyt słabe nazewnictwo
Zbyt skomplikowany kod
Powtarzające się kawałki kodu
Brak kontroli nad przepływem
danych.
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Udoskonalanie istniejącego kodu

Problemy do rozwiązania

Brak organizacji - przemyśl wybór wzorca projektowego. Najczęściej
stosuje się maszynę stanów lecz może w tym przypadku wzorzec
Producent/Consument będzie lepszy.
Zbyt słabe nazewnictwo - zmień nazwy kontrolek i indykatorów tak by
było oczywiste do czego służą.
Zbyt skomplikowany kod - zastanów się czy nie można danej operacji
wykonać w sposób prostszy. Przykład: obsługa silnika krokowego.
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Udoskonalanie istniejącego kodu

Problemy do rozwiązania
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Udoskonalanie istniejącego kodu

Problemy do rozwiązania

Powtarzające się kawałki kodu - zamknij je w subVI, który dobrze
udokumentuj (zmień ikonę z domyślnej na sugerującą działanie, dodaj
opis do pomocy kontekstowej, dobież odpowiednio nazwy terminali).
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Udoskonalanie istniejącego kodu

Problemy do rozwiązania

Brak kontroli nad przepływem danych - zastąp Sequence structures
maszyną stanów, jeśli to możliwe usuń zmienne lokalne w zamian
przekazując wartości bezpośrednio z kontrolek lub stosując
kolejkę/FGV.
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Dystrybucja gotowej aplikacji Przygotowanie plików

Przygotowanie plików

Główny VI zmodyfikuj korzystając z VI Properties jako Top-level
application.
Wykorzystaj properties nodes i invoke nodes do zmiany wyglądu
kontrolek/okna. Wyłącz niepotrzebne paski narzędzi (toolbar), suwaki
itd.
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Dystrybucja gotowej aplikacji Przygotowanie plików

Przygotowanie ścieżek

Przygotuj ścieżki zależne od miejsca uruchomienia aplikacji a nie jako
stałe.
Pamiętaj, że ścieżki folderów mogą się różnić w zależności od
uruchomionego systemu operacyjnego.
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Dystrybucja gotowej aplikacji Przygotowanie plików

Zamknięcie aplikacji

Upewnij się, że w przypadku wystąpienia błędów aplikacja zostanie
zamknięta.
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Dystrybucja gotowej aplikacji Tworzenie specyfikacji
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Tworzenie specyfikacji
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Dystrybucja gotowej aplikacji Tworzenie specyfikacji

Build Status
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Dystrybucja gotowej aplikacji Tworzenie specyfikacji

Run EXE

Angelika Tefelska PPPW 2022/2023 57 / 83



Dystrybucja gotowej aplikacji Tworzenie instalatora

Dlaczego warto tworzyć instalator?

Do wykonywania się aplikacji w LabVIEW nie potrzeba tak naprawdę
LabVIEW. Wystarczy darmowe oprogramowanie: LabVIEW Run-Time
Engine (RTE).
Jeśli aplikacja korzysta z pobranych sterowników, można wymusić ich
instalację wraz z plikiem EXE.
Instalator zapewnia skopiowanie niezbędnych plików do pożądanej
lokalizacji.
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Dystrybucja gotowej aplikacji Tworzenie instalatora

Installer Properties
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Installer Properties
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Dystrybucja gotowej aplikacji Tworzenie instalatora

Instalacja
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Tips & Tricks

Tips & Tricks
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Tips & Tricks Basic tricks

Organizacja elementów na front panel-u

Elementy na front panelu można oddzielać dekoracjami lub zgrupować
w różnych zakładkach Tab Control .
Tab control zwraca numer zakładki, który użytkownik wyświetla
numerując od zera.
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Tips & Tricks Basic tricks

Organizacja elementów z wykorzystaniem dekoracji

Angelika Tefelska PPPW 2022/2023 64 / 83



Tips & Tricks Basic tricks

Organizacja elementów z wykorzystaniem subVI

Część parametrów można podawać bezpośrednio w wyskakującym
subVI. W tym celu oszczędza się miejsce na front panelu.
SubVI musi otwierać się w momencie uruchomienia. W tym celu
należy wybrać odpowiednią opcję w VI properties.
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Tips & Tricks Basic tricks

Organizacja elementów z wykorzystaniem subVI
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Tips & Tricks Basic tricks

Ukrywanie menu
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Tips & Tricks Basic tricks

Front Panel na środku ekranu
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Tips & Tricks Basic tricks

Ukrywanie scrollbar-ów
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Tips & Tricks Basic tricks

Zmiana stylu kursora

Czasami dobrze jest zmienić wygląd kursora np. na klepsydrę w czasie
wczytywania/generowania dużych ilości danych.
W tym celu należy skorzystać z odpowiednich funkcji znajdujących się
w: Functions Palette→Dialog & User Interface→Cursor
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Tips & Tricks Basic tricks

Zmiana stylu kursora
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Tips & Tricks Basic tricks

Usuwanie obramowań klastrów

Przetwarzanie danych w klastrze jest wygodniejsze lecz obramowanie
klastra może wyglądać nieestetycznie.
Obramowanie klastra z palety Classic można ukryć wybierając:

1 View→Tools Palette,
2 w narzędziu do zmiany koloru wybieramy kolor przezroczysty (T),
3 zmieniamy kolor klastra,
4 klikamy na klaster i wybieramy Visible Items→Label
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Tips & Tricks Basic tricks

Zmiana stylu kontrolek/indykatorów

Czasami standardowy wygląd kontrolki/indykatora nie jest
zadowalający.
Wszystkie kontrolki/indykatory z palety Classic można edytować. W
tym celu:

1 Kliknij prawym przyciskiem na danym obiekcie i wybierz:
Advanced→Customize....

2 Następnie wybierz: Window→Show Parts Window. W powstałym
okienku wybierasz część danego obiektu, którą chcesz modyfikować.

3 Kliknij prawym przyciskiem myszy na części obiektu, który chcesz
edytować a rozwinie się lista opcji z których możesz skorzystać.
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Tips & Tricks Basic tricks

Kontrolki/Indykatory na obrazku
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Tips & Tricks Basic tricks

Animacja za pomocą picture ring
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Tips & Tricks Basic tricks

Podświetlanie elementów
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Tips & Tricks Grafika

Grafika 2D
Grafikę 2D można tworzyć wykorzystując funkcję z: Graphics & Sound
→ Picture Functions.
Przykład dodawania punktów do obrazka. Pamiętaj, że obrazek ma
wymiary, które można odczytać korzystając z property nodes - bounds.
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Tips & Tricks Grafika

Grafika 2D
Obiekty, które można narysować:

punkt,
linię,
prostokąt,
okrąg,
tekst.
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Tips & Tricks Grafika

Grafika 3D

Grafikę 2D można tworzyć wykorzystując funkcję z: Graphics & Sound
→ 3D Picture Control.
Przykład rysowania prostopadłościanu.
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Tips & Tricks Grafika

Grafika 3D
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Tips & Tricks Grafika

Dostępne geometrie
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end

Dziękuję za uwagę!

Wsparcie Komisji Europejskiej dla produkcji tej publikacji nie stanowi poparcia dla treści, które odzwierciedlają jedynie poglądy
autorów, a Komisja nie może zostać pociagnięta do odpowiedzialności za jakiekolwiek wykorzystanie informacji w niej zawartych.

Wykład został opracowany w oparciu o materiały: ”LabVIEW Core 1 Course Manual”, ”LabVIEW Core 2 Course Manual”,
pierwotną wersje wykładu: mgr. inż. Marcina Biedy oraz przykładowe egzaminy CLAD opublikowane na stronie www.ni.com .
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